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WARNINGS AND PRECAUTIONS

READ ALL PRODUCT MANUALS AND CONSULT WITH BECKMAN COULTER-TRAINED PERSONNEL BEFORE ATTEMPTING
TO OPERATE INSTRUMENT. DO NOT ATTEMPT TO PERFORM ANY PROCEDURE BEFORE CAREFULLY READING ALL
INSTRUCTIONS. ALWAYS FOLLOW PRODUCT LABELING AND MANUFACTURER’S RECOMMENDATIONS. IF IN DOUBT AS
TO HOW TO PROCEED IN ANY SITUATION, CONTACT YOUR BECKMAN COULTER REPRESENTATIVE.

HAZARDS AND OPERATIONAL PRECAUTIONS AND LIMITATIONS

WARNINGS, CAUTIONS, and IMPORTANTS alert you as follows:

WARNING - Can cause injury.
CAUTION - Can cause damage to the instrument.
IMPORTANT - Can cause misleading results.

BECKMAN COULTER, INC. URGES ITS CUSTOMERS TO COMPLY WITH ALL NATIONAL HEALTH AND SAFETY
STANDARDS SUCH AS THE USE OF BARRIER PROTECTION. THIS MAY INCLUDE, BUT IT IS NOT LIMITED TO,
PROTECTIVE EYEWEAR, GLOVES, AND SUITABLE LABORATORY ATTIRE WHEN OPERATING OR MAINTAINING THIS OR
ANY OTHER AUTOMATED LABORATORY ANALYZER.

WARNING Risk of operator injury if:
¢ All doors, covers and panels are not closed and secured in place prior to and during instrument operation.
* The integrity of safety interlocks and sensors is compromised.
« Instrument alarms and error messages are not acknowledged and acted upon.
* You contact moving parts.
¢ You mishandle broken parts.
¢ Doors, covers and panels are not opened, closed, removed and/or replaced with care.
e Improper tools are used for troubleshooting.
To avoid injury:
« Keep doors, covers and panels closed and secured in place while the instrument is in use.
 Take full advantage of the safety features of the instrument. Do not defeat safety interlocks and sensors.
* Acknowledge and act upon instrument alarms and error messages.
e Keep away from moving parts.
« Report any broken parts to your Beckman Coulter Representative.
« Open/remove and close/replace doors, covers and panels with care.
« Use the proper tools when troubleshooting.

CAUTION System integrity might be compromised and operational failures might occur if:
« This equipment is used in a manner other than specified. Operate the instrument as instructed in the Product Manuals.

* You introduce software that is not authorized by Beckman Coulter into your computer. Only operate your system’s
computer with software authorized by Beckman Coulter.

* You install software that is not an original copyrighted version. Only use software that is an original copyrighted
version to prevent virus contamination.

IMPORTANT If you purchased this product from anyone other than Beckman Coulter or an authorized Beckman Coulter
distributor, and, if it is not presently under a Beckman Coulter service maintenance agreement, Beckman Coulter cannot
guarantee that the product is fitted with the most current mandatory engineering revisions or that you will receive the most
current information bulletins concerning the product. If you purchased this product from a third party and would like
further information concerning this topic, call your Beckman Coulter Representative.




REVISION STATUS -

Issue A, Initial Issue, 6/03
CXP Software Version 1.0. Initial issue for customer distribution.

Issue B, 6/04
CXP Software Version 2.0.

Additions, changes or deletions were made at these locations:

1-3,1-5, 1-6, 1-10, 1-14, 1-24, 1-27, 1-31, 1-31, 1-32, 1-36, 1-41, 1-43, 1-46, 1-50, 2-8,
2-13,2-22,2-26, 2-30, 2-35, 2-38, 2-41, 2-47, 2-54, 2-55, 2-58, 2-59 and A-1 through A-7.

This document applies to the latest software listed and higher versions. When a subsequent software version
changes the information in this document, a new issue will be released.
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INTRODUCTION -

This introductory section contains the following topics:

e USING YOUR Cytomics FC 500 MANUALS
e ABOUT THIS MANUAL

¢ CONVENTIONS, and

e GRAPHICS.

USING YOUR Cytomics FC 500 MANUALS

The manuals listed below are available as PDF files in the FC 500 CXP software and the
Operator’s Manuals CD-ROM. Printed versions of these manuals are also available by order.

Use the Reference manual for instrument specifications and information on installation and
system options.

Use the Instructions For Use manual for the day-to-day running of your instrument. Go
through the detailed step-by-step procedures of startup, quality control (QC), running
samples, analyzing data, printing reports, reviewing QC data, shutdown. It contains safety
and troubleshooting information, error messages, as well as in-depth information on the
principles of flow cytometry, information about what your instrument does, and the methods
it uses.

Use the Special Procedures manual to clean, replace, or adjust a component of the instrument.
Use the Getting Started manual as a brief introduction to the system.

Use the Master Index to easily locate a topic in any of your manuals.

ABOUT THIS MANUAL

Your FC 500 Special Procedures manual describes how to clean, replace or adjust a
component of the system.

This information is organized as follows:

e Chapter 1, CLEANING PROCEDURES
Provides procedures for cleaning parts of the system.
*  Chapter 2, REPLACE/ADJUST PROCEDURES
Provides procedures for replacing or adjusting parts.
*  Appendix A, MAINTENANCE AND SERVICE LOGS
Provides procedures for entering comments in the Maintenance Log.
e INDEX

Use the Index to easily locate specific information in this manual.
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CONVENTIONS

CONVENTIONS

This manual uses the following conventions:

Throughout this manual your FC 500 is also referred to as the system or instrument.
Bold font indicates a software option, such as Cytometer.

Italics font indicates screen text displayed on the instrument, such as
Preparing Samples.

Courier font indicates text you have to type using the keyboard.

() indicates a key (such as (Enter)).

(J+() indicates that the two keys listed (such as (At}+(F2)) are linked for a specific
function and must be pressed in this sequence:

a. Press down on the first key listed and while continuing to press it, press down on
the second key listed.

b. Release both keys at the same time.

(J () indicates to press and release the first key listed then press and release the next

key listed. For example: (Enter).

Icons/buttons to select functions on the software screen are shown within text.

Uk
Example:

@ indicates to use the mouse to select the screen button labeled

@ File » Save indicates to use the mouse to select the Save item on the File menu.
through are special function keys.

A Note contains information that is important to remember or helpful in performing a
procedure.

The terms “screen” and “window” are used interchangeably.

SHOW ME means there is a video available for the procedure in the online help.
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To Choose A Command With The Keyboard

After you press (At), each menu name has one letter underlined to indicate which letter to use
to pull down the menu. For example, the letter F in the File menu is underlined, press (F] to
pull down the File menu, the letter E in the Edit menu is underlined, press (E] to pull down

the Edit menu.

Command  Function

Accepts your selection.

Stops the operation, discarding your choices.

Tab Moves cursor over different choices if there are multiple options - see

Windows® manuals for Windows operation via keyboard.

Alt}+{Tab When you have more than one application Window open, use (At}+{Tab) to
switch between tasks.

Dialog Box

Dialog boxes receive commands or information; for example, a file name dialog box receives
information about a file name.

Accepts the information you have selected or typed.

Stops the operation, ignoring your choices.
Cancel p p 8 gy

Description of Reporting Units

Unless otherwise stated, all parameter units are shown in the US unit format (cells/uL)
throughout the manuals.

GRAPHICS

All graphics, including screens and printouts, are for illustration purposes only and must not
be used for any other purpose.
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CLEANING PROCEDURES

1.1 WHAT THIS CHAPTER EXPLAINS

This chapter explains how to clean the:
e Sample system (daily) before the daily shutdown procedure, CLEAN THE SAMPLING
SYSTEM.

*  MCL sample head and sample probe (weekly), CLEAN THE MCL SAMPLE HEAD AND
THE SAMPLE PROBE.

e Air filters (weekly) after the shutdown procedure, CLEAN THE AIR FILTERS.
¢ Sheath fluid container (monthly), CLEAN THE SHEATH FLUID CONTAINER.

* C(Cleaning agent container (every 60 days), CLEAN THE CLEANING AGENT
CONTAINER.

e Vacuum trap (VAC TRAP) on the Power Supply (as needed), CLEAN THE VACUUM
TRAP.

Other general procedures in this chapter are:

e PUT THE CYTOMETER IN THE IDLE MODE
e  OPEN/REMOVE THE INSTRUMENT COVERS
¢ REMOVE THE REAGENT CONTAINERS

e REPLACE THE REAGENT CONTAINERS

e POWER THE CYTOMETER ONLY ON/OFF.

1.2 CLEANING SCHEDULE

See Table 6.1, Cleaning Schedule in the TROUBLESHOOTING chapter in the Instructions
For Use manual.
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CLEANING PROCEDURES
CLEAN THE AIR FILTERS

1.3  CLEAN THE AIR FILTERS

* Clean the air filters weekly per Table 6.1, Cleaning Schedule in the Instructions For Use
manual. It is easiest to clean the air filters after performing the shutdown procedure.

* Instructions and graphics are given for both Power Supply configurations. Use the
procedure (Procedure 1 or Procedure 2) that corresponds to your Power Supply
configuration.

Procedure 1

If you have the Universal Power Supply
configuration:

Follow Procedure 1 to clean the air
filters.

Location of Air Filters

The instrument has five air filters located
on the:

* Cytometer Back Panel (3)

e Power Supply, Left Side Panel (2).

1-2 PN 1755728



CLEANING PROCEDURES 1
CLEAN THE AIR FILTERS

Prepare to Clean the Air Filters

1 Power the Cytometer OFF.

2  Unplug both Power Supply power cords
© from the wall outlet.

3  Pull off each filter cover. Even though
the covers look like they are screwed in,
they are not.

The filter covers are made of flexible
plastic; they snap out when you pull
them. Grab a segment of the grille
between your thumb and index finger
and then pull.
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CLEANING PROCEDURES
CLEAN THE AIR FILTERS

4  Gently pinch and pull out each filter.

Handle them gently to avoid damaging
them.

Rinse and Return the Air Filters

1 Rinse each filter in water @, and then
wring it out @.

2 Set each filter aside and let it dry out
for about 30 minutes.

Use paper towels to check that each
filter is completely dry.
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CLEANING PROCEDURES
CLEAN THE AIR FILTERS

3  Return each filter into its holder.
Replace any torn filters.

4 Put each filter cover back on.

9 Plug in both Power Supply power

cords @ into the wall outlet.

1-5
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CLEANING PROCEDURES
CLEAN THE AIR FILTERS

6  Power the Cytometer Only ON or
Power the Cytometer and CXP
Software ON.

7 Record that the air filters were Weekly .
cleaned on the electronic -
8 Clean Air Filkers .
Maintenance Log.

8 Perform the Daily Startup procedure
before running samples.

Procedure 2

If you have the Voltage-specific Power
Supply configuration:

Follow Procedure 2 to clean the air
filters.
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CLEANING PROCEDURES 1
CLEAN THE AIR FILTERS

Location of Air Filters

The instrument has four air filters
located on the:

e Power Supply, Back Panel (2).

* Cytometer Back Panel (2)

Prepare to Clean the Air Filters

1 Power the Cytometer OFF.

2  Unplug both Power Supply power cords
© from the wall outlet.
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CLEANING PROCEDURES
CLEAN THE AIR FILTERS

3  Pull off each filter cover. Even though
the covers look like they are screwed in,
they are not.

The filter covers are made of flexible
plastic; they snap out when you pull
them. Grab a segment of the grille
between your thumb and index finger
and then pull.

4  Gently pinch and pull out each filter.

Handle them gently to avoid damaging
them.
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CLEANING PROCEDURES 1
CLEAN THE AIR FILTERS

Rinse and Return the Air Filters

1 Rinse each filter in water @, and then
wring it out @.

{ a7
Vooost| |1 sbe
S

2  Set each filter aside and let it dry out
for about 30 minutes.

Use paper towels to check that each
filter is completely dry.

3  Return each filter into its holder.
Replace any torn filters.
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CLEANING PROCEDURES
CLEAN THE AIR FILTERS

4 Put each filter cover back on.

9  Plug in both Power Supply power
cords @ into the wall outlet.

OO
O)]
e

6 Power the Cytometer Only ON or
Power the Cytometer and CXP
Software ON.

7 Record that the air filters were Weekly .
cleaned on the electronic -
8 Clean Air Filkers .
Maintenance Log.
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CLEANING PROCEDURES 1
OPEN/REMOVE THE INSTRUMENT COVERS

8 Perform the Daily Startup procedure
before running samples.

1.4 OPEN/REMOVE THE INSTRUMENT COVERS

Open the Front Cover
Click SHow ME for an overview.

1  Pull the front cover forward @ and then /
lift straight up @.
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CLEANING PROCEDURES
OPEN/REMOVE THE INSTRUMENT COVERS

1-12

Push the front cover back until you
hear both sides click and lock in place.

You only need to open the front cover
this much if you are going to perform a
procedure such as:

REMOVE THE REAGENT
CONTAINERS

REPLACE THE REAGENT
CONTAINERS

CLEAN THE SHEATH FLUID
CONTAINER

CLEAN THE CLEANING AGENT
CONTAINER

REPLACE THE SHEATH FLUID
FILTER

FILL THE SHEATH FLUID
CONTAINER

FILL THE CLEANING AGENT
CONTAINER

VENT THE AIR BUBBLES
POSITION THE FIELD STOP.

If you need to perform:

CLEAN THE MCL SAMPLE HEAD
AND THE SAMPLE PROBE

REPLACE THE SAMPLE PROBE AND
SAMPLE PICKUP TUBING

REPLACE THE MCL SAMPLE HEAD

REPLACE THE OPTICAL FILTER
PLATE

REPLACE A FILTER IN THE OPTICAL
FILTER PLATE,

Pivot the front cover back until it is
over the top of the instrument and you
hear both sides click and lock in place.
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CLEANING PROCEDURES 1
OPEN/REMOVE THE INSTRUMENT COVERS

Close the Front Cover
Click SHow ME for an overview.

1 While holding the bottom of the front
cover with one hand, pull out the
release pin with your free hand.

2  Switch hands so your other hand is
holding the bottom of the front cover.
Pull out the second release pin with
your free hand.
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CLEANING PROCEDURES
OPEN/REMOVE THE INSTRUMENT COVERS

3  Using both hands, pivot the front cover
forward until it is vertical.

WARNING Risk of operator injury. To prevent
injury, hold your hands flat on the sides of the
cover. Ensure your fingers are not behind the
cover as you push down and in to close it.

4  Ensure your fingers are not behind the
cover. Push the cover down and in to
close it.
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Remove the Front Left Side Panel
Click SHow ME for an overview.

CLEANING PROCEDURES
OPEN/REMOVE THE INSTRUMENT COVERS

1 Power the Cytometer OFF.

2  Unscrew the two bolts that attach the
left side panel to the front frame @.

3 Snap off the left side panel @.

1-15
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CLEANING PROCEDURES
OPEN/REMOVE THE INSTRUMENT COVERS

Replace the Front Left Side Panel
Click SHow ME for an overview.

1 Snap on the left side panel @.

2  Screw in the two bolts to attach the left
side panel to the front frame @.

3  Power the Cytometer Only ON or
Power the Cytometer and CXP
Software ON.
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CLEANING PROCEDURES 1
OPEN/REMOVE THE INSTRUMENT COVERS

Open the MCL Cover

1 Lift up the MCL cover.

Close the MCL Cover

1  Close the MCL cover.
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CLEANING PROCEDURES
PUT THE CYTOMETER IN THE IDLE MODE

1.5

1.6

1-18

PUT THE CYTOMETER IN THE IDLE MODE

To clean, replace, or fill the reagent containers you need to put the Cytometer in the Idle

mode.

1 To put the Cytometer in the Idle
mode:

2 Wait about 10 seconds for the
Cytometer to depressurize. The
message Press Idle Mode button to
initialize appears at the bottom of the
screen when the Cytometer is
depressurized.

|Press Idle Mode buttan ta initialize]

REMOVE THE REAGENT CONTAINERS

Remove a reagent container to perform these procedures:

¢ (Clean the sheath fluid container

* (Clean the cleaning agent container

* Replace a reagent container. Clean any new reagent container before using it.

Procedure

1 Check if the instrument is currently
displaying the Idle mode:

||Press Idle Mode button to initialize|

* If yes (Press Idle Mode button to
initialize appears), go to step 2.

e Ifno, PUT THE CYTOMETER IN
THE IDLE MODE.
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CLEANING PROCEDURES 1
REMOVE THE REAGENT CONTAINERS

2  Open the Front Cover.
SHow ME.

3  Pull open the reagent drawer until it
stops.

@ Reagent container connectors.
® Cleaning agent container.
© Sheath fluid container.

Note: The reagent drawer sits in a
self-locking track so it only opens part
way and stops.
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CLEANING PROCEDURES
REMOVE THE REAGENT CONTAINERS

4  Disconnect the tubing on the top of
each reagent container by pushing in
on the metal clips on the connectors.

9 Press down on the left locking tab and
press up on the right locking tab of the
reagent drawer.

6  Pull open the reagent drawer farther
out but not all the way.
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CLEANING PROCEDURES 1
REMOVE THE REAGENT CONTAINERS

7 Disconnect each sensor at the back of
the drawer by sliding its sleeve out:

e The sensor for the sheath fluid
container (shown here) is on the
right.

* The sensor for the cleaning agent
container is on the left.

8 Unfasten the flexible strap that holds
the sheath fluid filter in place.
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CLEANING PROCEDURES
REMOVE THE REAGENT CONTAINERS

9  Lift up the sheath filter to loosen its
connected tubing.

10 Remove the container from the drawer,
unscrew the cap and empty the
container as completely as possible
(sheath fluid container is shown).

11 Clean up any spills or debris in the
drawer.
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CLEAN THE SHEATH FLUID CONTAINER

CLEANING PROCEDURES
CLEAN THE SHEATH FLUID CONTAINER

IMPORTANT Misleading results could occur if you contaminate the sheath fluid container. Be careful not to
contaminate the sheath fluid container. Do not let your fingers, paper towels, or other objects touch the
inside of the container or the inside of its cap.

Remove and clean the sheath fluid container monthly. See Table 6.1, Cleaning Schedule

in the Instructions For Use manual.

Clean a new sheath fluid container before placing it into the reagent drawer.

See REMOVE THE REAGENT
CONTAINERS to remove the sheath
fluid container.

Position a funnel into the sheath fluid
container.

Pour about 100 to 200 mL of fresh
IsoFlow™ sheath fluid or equivalent
into the sheath fluid container.

Screw the cap back on the sheath fluid
container.

Swirl the sheath fluid in the sheath
fluid container, rinsing all surfaces.

1-23
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CLEANING PROCEDURES
CLEAN THE SHEATH FLUID CONTAINER

1-24

9 Empty the container as completely as
possible. Q
Q
6 Rlecorcl1 that Lhe slheath (.:ontai.ner was Monthly
cleaned on the electronic Maintenance Clean Sheath Tark .
Log.
7 See REPLACE THE REAGENT

CONTAINERS to replace the sheath
fluid container.

PN 175572B



1.8

PN 175572B

CLEAN THE CLEANING AGENT CONTAINER

CLEANING PROCEDURES
CLEAN THE CLEANING AGENT CONTAINER

Remove and clean the cleaning agent container every 60 days. See Table 6.1, Cleaning

Schedule in the Instructions For Use manual.

Clean a new cleaning agent container before placing it into the reagent drawer.

See REMOVE THE REAGENT
CONTAINERS to remove the cleaning
agent container.

Position a funnel into the cleaning
agent container.

Pour about 50 to 100 mL of fresh
IsoFlow sheath fluid or equivalent into
the cleaning agent container.

i
o\

Screw the cap back on the cleaning
agent container.

Swirl the sheath fluid in the sheath
fluid container, rinsing all surfaces.

1-25
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CLEANING PROCEDURES
CLEAN THE CLEANING AGENT CONTAINER

9 Empty the container as completely as

possible. </

6  Position a funnel into the cleaning
agent container.
Pour about 50 to 100 mL of fresh
COULTER CLENZ® cleaning agent or

equivalent into the cleaning agent
container.

liypyY
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CLEANING PROCEDURES 1
CLEAN THE CLEANING AGENT CONTAINER

7  Empty the container as completely as

possible. </

8 Record that the cleanse container was
cleaned on the electronic Maintenance
Log.

Ewvery 60 days
Clean Cleanze Tank .

9 See REPLACE THE REAGENT
CONTAINERS to replace the cleaning
agent container.
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CLEANING PROCEDURES
REPLACE THE REAGENT CONTAINERS

1.9 REPLACE THE REAGENT CONTAINERS

Use this procedure to return a cleaned reagent container into the reagent drawer.

1 Put the clean reagent container back
into the drawer.

2 Check that the sensor connector at the
back of the container goes through the
hole in the back of the reagent drawer.

With the arrows visible on top of the
sensor, reconnect the sensor (sheath
fluid sensor is shown).
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CLEANING PROCEDURES 1
REPLACE THE REAGENT CONTAINERS

3  Slide the reagent drawer back in part
way. Keep the neck of the reagent
container out.

4  Reconnect the tubing assembly by
pushing down on the tubing inserts so
that the tubing snaps into the
connector.

9  Fill each reagent container as
instructed in these procedures:

e FILL THE SHEATH FLUID
CONTAINER and VENT THE AIR
BUBBLES, or

e FILL THE CLEANING AGENT
CONTAINER.
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CLEANING PROCEDURES
REPLACE THE REAGENT CONTAINERS

6 Check that:

* The sheath filter vent port @ is
above the connector @.

* The tubing is not kinked or
twisted.

T  Close the reagent drawer.
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CLEANING PROCEDURES 1
CLEAN THE VACUUM TRAP

WARNING Risk of operator injury. To prevent
injury, hold your hands flat on the sides of the
cover. Ensure your fingers are not behind the
cover as you push down and in to close it.

8 Close the Front Cover.
SHow ME.

1.10 CLEAN THE VACUUM TRAP

* (Clean the vacuum trap @ as needed.

*  Check for fluid in the vacuum trap (VAC TRAP) on the front of the Power Supply as part
of your Daily Startup procedure.

e If the vacuum trap is more than one-quarter full of fluid, empty it and rinse with tap
water.

Instructions and graphics are given for both Power Supply configurations (shown below).

\,LL\

e

WATER

S ]
gL AR
G |
18!

s | s

PRESS

7]

_——
O 1 "

To clean the Vacuum Trap, perform these procedures:

* Prepare to Clean the Vacuum Trap
e Find and Pull Out the Vacuum Trap

* Rinse and Return the Vacuum Trap to Its Bracket.
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CLEANING PROCEDURES
CLEAN THE VACUUM TRAP

Prepare to Clean the Vacuum Trap

1 Power the Cytometer OFF.

2  Unplug both Power Supply power
cords @ from the wall
outlet.
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Find and Pull Qut the Vacuum Trap

CLEANING PROCEDURES
CLEAN THE VACUUM TRAP

1 The vacuum trap is the trap on the left.
Lift the vacuum trap assembly out of its
bracket so that you can grasp the top of
the assembly.

WARNING To prevent injury, avoid skin contact
with the vacuum trap and its associated tubing.
The vacuum trap and its associated tubing might
contain residual biological material and must be
handled with care. Clean up spills immediately.
Dispose of the contents of the vacuum trap in
accordance with your local environmental
regulations and acceptable laboratory procedures.

2  While using one hand to hold the top
of the vacuum trap assembly, use the
other hand to unscrew the vacuum
trap. Then, empty the vacuum trap
according to your local environmental
regulations and your laboratory's
procedures.
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Rinse and Return the Vacuum Trap to Its Bracket

1  Rinse the vacuum trap with water, and \
then shake out the excess water.

2  Insert the white center post, pointed
end up, into the vacuum trap assembly.

If the white center post in the vacuum
trap assembly is stuck in the up
position @, pull it into the down
position @.
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3  Carefully align the threads on the
vacuum trap jar with the threads on the
vacuum trap assembly and screw the
vacuum trap back into place.

4  Return the vacuum trap assembly to its
bracket.

9  Wipe up any spills.

g = l rl|l1|i i|rlll1|-

© VA( WATER
TRA| TRAP
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CLEAN THE VACUUM TRAP

6  Plugin both Power Supply power cords
© into the wall
outlet.

T  Power the Cytometer Only ON or Power the Cytometer and CXP Software ON.

8  Check that no error messages are displayed.

Note: If an error message appears, see Table 6.2, Error Messages in the Instructions For
Use manual for possible causes and operator actions.

9  Awaiting Sample appears at the bottom of the screen when system initialization is done.

10 Record that the vacuum trap was As Needed .
cleaned on the electronic Maintenance

Clean Wacuum Trap
Log. .

11 Perform the Daily Startup procedure before running samples.
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1.11 CLEAN THE SAMPLING SYSTEM

Routine daily cleaning helps to minimize instrument downtime.

Levels of System Cleaning
The two levels of cleaning for the system are:

* Routine cleaning followed by sample head/probe cleaning.

* Vacuum line cleaning.

When to Clean the Sampling System

Routine and Sample Head Cleaning Procedures
Perform both the routine and the sample head/probe cleaning procedures:

*  When you change laboratory application procedures, especially if you are using vital
fluorescent stains. If vital stains such as propidium iodide, ethidium bromide, acridine
orange, thiazole orange, Coriphosphine-O, Fura 3, or fluorescein diacetate, are used,
perform these cleaning procedures immediately after using the dyes.

* Immediately prior to running any immunophenotyping application if vital stains are
being used on the same instrument.

*  When you observe a significant increase in debris or background counts.
* Before you perform the Vacuum Line Cleaning Procedure.

* Before you perform Daily Shutdown.

Vacuum Line Cleaning
Perform the vacuum line cleaning procedure:

*  When you change laboratory application procedures, especially if you are using vital
fluorescent stains. If vital stains such as propidium iodide, ethidium bromide, acridine
orange, thiazole orange, Coriphosphine-O, Fura 3, or fluorescein diacetate, are used,
perform these cleaning procedures immediately after using the dyes.

* After every 8 hours of continuous operation.

* Before you perform Daily Shutdown.
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CLEAN THE SAMPLING SYSTEM

Routine Cleaning Procedure

Perform this procedure as often as described in the heading When to Clean the Sampling
System.

WARNING The cleaning solution is hazardous and can cause personal injury or damage clothing. Beckman
Coulter urges its customers to comply with all national health and safety standards such as the use of
barrier protection. This may include, but it is not limited to, protective eyewear, gloves, and suitable
laboratory attire when operating or maintaining this or any other automated laboratory analyzer.

IMPORTANT A cleaning solution that is not fresh can leave residual stain in the system and misleading
results could occur when you change laboratory applications. Be sure to prepare a fresh cleaning solution
before performing the cleaning procedure and use it within the same day.

1 Prepare a cleaning solution of 1 part T
high-quality, fragrance-free bleach @ ~N—
(5% or 6% solution of sodium

hypochlorite - available chlorine) and
9 parts distilled water or IsoFlow
sheath fluid @.

2 Put 2 mL of the bleach solution @ in a
test tube.
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CLEAN THE SAMPLING SYSTEM

Load the carousel:

@ Put the test tube of bleach solution
into carousel position 1.

@ Put three freshly prepared tubes,
each containing about 2 mL of distilled
water or IsoFlow sheath fluid, into
positions 2, 3, and 4 of the carousel.

Select the cleaning panel if it is not
currently selected:

UG

¢ Select Cleanse.PNL from the list of
panels.

U=

Nicko - Open Panel

Loak in: I =5 Panel

J s e =

File name: |EIeanse.PNL

Open I

Files of type: IPaneI Files [*.prl)

j Cancel |

4
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CLEAN THE SAMPLING SYSTEM

9  Put the carousel into the MCL sample
loader.

Close the MCL cover.

* Enter the Carousel No. in the Worklist. Carousel
The tube Location numbers Ho. Location
automatically appear. 22 1
2 2
22 3
22 4
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CLEAN THE SAMPLING SYSTEM

7  When the cleaning panel is done,
remove the carousel.

8 Close the MCL cover.

9  Record that the routine cleaning Daily Shutdown .
procedure was performed on the Routine Cleaning .
electronic Maintenance Log.

10 Before running samples:

@ -3
to initialize the system.

Testing for Residual Stain

If you use vital stains such as propidium iodide, ethidium bromide, acridine orange, thiazole
orange, Coriphosphine-O, Fura 3, or fluorescein diacetate, you may want to test for residual
stain after performing the routine cleaning procedure and before proceeding to your next
application.

To test for residual stain, run unstained Immuno-Trol™ cells or CYTO-TROL™ control cells
for your application to ensure that the autofluorescent population is where you normally
expect it. If it is not, repeat the routine cleaning procedure.

PN 1755728 1-41



CLEANING PROCEDURES
CLEAN THE SAMPLING SYSTEM

MCL Sample Head and Sample Probe Cleaning Procedure

Perform this procedure as often as described in the heading When to Clean the Sampling
System.

1 Prepare a cleaning solution of 1 part of T
high-quality, fragrance-free bleach @ ~N——
(5% or 6% solution of sodium
hypochlorite - available chlorine) and
9 parts distilled water or IsoFlow

sheath fluid @.

2  While wearing suitable laboratory 0
protective gloves, apply the 10% bleach \
solution @ to a gauze pad.

3  Open the MCL cover.

Note: If a carousel is present, remove it.
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CLEAN THE SAMPLING SYSTEM

1

4  Carefully push the moistened gauze
pad up against the inside of the MCL
sample head @ and scrub away any
debris inside and around the sample
probe.

9 Continue scrubbing the sample head
and probe by pushing the head up and
down 10 times during a 60-second
period. Replace moistened gauze as
needed.

6  Rinse the MCL sample head and probe
with gauze moistened with water.

7  Record that the sample head cleaning Weekly .
procedure was performed on the Clear A Fiters
electronic Maintenance Log. Clean MCL Head/Prabe .

8 Perform the Vacuum Line Cleaning
Procedure.
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Vacuum Line Cleaning Procedure

Perform this procedure as often as described in the heading When to Clean the Sampling
System.

1 Put 5 mL of distilled water into the fill
reservoir of two cleaning adaptors.

2  Load the cleaning adaptors into a
carousel:

© Put the cleaning adaptors into
positions 1 and 2 of the carousel.

@ Position the fill reservoirs toward the
center of the carousel.
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3  Put the carousel into the MCL and
close the MCL cover.

4 @zzz

9  When the message Press Idle Mode
button to Initialize appears at the
bottom of the screen:

Ukl

6  The message Cleanse cycle in progress
appears during the cleaning cycle.

When the cleaning cycle is done, the
message changes back to Press Idle
Mode button to Initialize.
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CLEAN THE SAMPLING SYSTEM

7 Remove the carousel.

8 Close the MCL cover.

9  Record that the vacuum line cleaning 5 ample Head/Probe
procedure was performed on the Vacuum Line Clean .
electronic Maintenance Log.

10 Before running samples:

@ -3
to initialize the system.
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1.12 CLEAN THE MCL SAMPLE HEAD AND THE SAMPLE PROBE

Do this procedure weekly to remove any crystal or debris buildup. To see a video of this
condition, click SHOw ME.

Click SHow ME for an overview.

1 Power the Cytometer OFF.

2 Lift up the MCL cover.

Note: If a carousel is present, remove it.

3  Open the Front Cover.
SHow ME.
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CLEAN THE MCL SAMPLE HEAD AND THE SAMPLE PROBE

4 Remove the Front Left Side Panel:

© Unscrew the two bolts that attach
the left side panel to the front frame.

® Snap off the left side panel.
SHow ME.

9 Moisten a Q-tip with distilled water.
SHow ME.
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6  Clean the top of the MCL sample head
and the bottom of the sample probe
holder.

7  Replace the Front Left Side Panel:
© Snap on the left side panel.

® Screw in the two bolts to attach the
left side panel to the front frame.

SHow ME.
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WARNING Risk of operator injury. To prevent
injury, hold your hands flat on the sides of the
cover. Ensure your fingers are not behind the
cover as you push down and in to close it.

8 Close the Front Cover.
SHow ME.

9 Close the MCL cover.

10 Record that the sample head cleaning Weekly .
procedure was performed on the Clea Air Filters
electronic Maintenance Log. Clean MCL Head/Prabe .

11 Power the Cytometer Only ON or
Power the Cytometer and CXP
Software ON.
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1.13 POWER THE CYTOMETER ONLY ON/OFF

Use the procedures below if the instrument has not been fully shut down.
Otherwise use these more detailed procedures located in the Instructions For Use manual:
e Use the Power the Computer and Cytometer ON procedure if you need to start up the

instrument and computer from a fully shut down condition.

* Use the Power the Computer and Cytometer OFF procedure if you need to fully shut
down the instrument and the computer.

Power the Cytometer Only ON

Use this procedure if the computer is already on and you do not need to start the CXP
software.

1 On the Windows desktop:

@ ﬁj to power up

% CxP Analysis

ﬂ}g CAP Cytometer

A
@ FC OM {Warmup) k

ONLY the Cytometer. O o
E Programs L4
:z @ Documents L4
E % Settings 4
g @ Search L4
= @ Help
Run...

Shut Down. ..
I;astart |J
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Power the Cytometer and CXP Software ON

Use this procedure if the computer is already on and you want to start the Cytometer and the
CXP software.

1 On the Windows desktop:

@ @ to start the CXP

software and power up the Cytometer.

CxP Analysis

FC OM {MWarmup)

FC OFF

;@
@
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Power the Cytometer OFF

Use this procedure to turn off the Cytometer and close the CXP software.

You can still work with the Windows® software after the Cytometer shuts off.

_[&] x|
1 @ in all open CXP windows.

cxP X
2 | ez or Mo @ Before continuing, do you want to save the curent protocol?

PROTOCOL1.PRO
I~ Da not shaw this dialog box again this session

es Mo Cancel

@ @ CxP Analysis
3 » to turn off the CHP Cytometer

Cytometer.
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REPLACE/ADJUST PROCEDURES

2.1 WHAT THIS CHAPTER EXPLAINS

List of Replacement and Adjustment Procedures
This chapter has these replacement and adjustment procedures:

e REPLACE REAGENTS

e FILL THE SHEATH FLUID CONTAINER

e VENT THE AIR BUBBLES

e FILL THE CLEANING AGENT CONTAINER

e EMPTY THE WASTE CONTAINER

e REPLACE THE SHEATH FLUID FILTER

e REPLACE THE SAMPLE PROBE AND SAMPLE PICKUP TUBING
e REPLACE THE MCL SAMPLE HEAD

e ADJUST THE SYSTEM PRESSURE

e REPLACE THE OPTICAL FILTER PLATE

e REPLACE A FILTER IN THE OPTICAL FILTER PLATE
e POSITION THE FIELD STOP

e RESET THE CIRCUIT BREAKERS

e ADJUST THE HENE LASER.

2.2 REPLACEMENT/ADJUSTMENT SCHEDULE

See the Replacement Schedule in the TROUBLESHOOTING Chapter in the Instructions For
Use manual.

2.3 REPLACE REAGENTS

About the Reagent Containers

* The Cytometer has a reagent drawer

that has containers for cleaning agen

. Bagent =
© and sheath fluid @.

e For best use of reagents, refill the
reagent containers only when the
instrument indicates that they are

low.
e If 1 t contai ] Q
you replace a reagent container, ot |
clean it before you put it into the
instrument and fill it. See CLEAN / QJ

THE SHEATH FLUID CONTAINER
or CLEAN THE CLEANING AGENT
CONTAINER.
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FILL THE SHEATH FLUID CONTAINER

Reagent Container Capacity

The sheath fluid container has a working capacity of about 2 L. This is the amount of reagent
needed when you are filling the sheath fluid container after the Sheath Low indicator appears.
When you fill a completely empty sheath fluid container (after cleaning or replacement), you
need about 2.8 L of sheath fluid due to pressurization and level sensing requirements.

Note: A bottle of IsoFlow sheath fluid holds 1.8 L.

The cleaning agent container has a working capacity of about 500 mL. This is the amount of
reagent needed when you are filling the sheath fluid container after Cleanse Level Warning or
Cleanse Level Error appears. When you fill a completely empty cleaning agent container (after
cleaning or replacement), you need about 1 L of cleaning agent due to pressurization and
level sensing requirements.

Note: A bottle of COULTER CLENZ cleaning agent holds 500 mL.

2.4  FILL THE SHEATH FLUID CONTAINER

Perform this procedure whenever:

*  You clean or replace the sheath fluid
container.

e The Sheath Low indicator @ appears.

* The Sheath Level Warning or Sheath
Level Error appears.

1 Check if the instrument is currently in
the Idle mode:

* If yes (Press Idle Mode button to
initialize appears), go to step 3.

e Ifno, PUT THE CYTOMETER IN
THE IDLE MODE.

||Press Idle Mode button to initialize|
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2  Open the Front Cover.
SHow ME.

3  Pull open the reagent drawer until it
stops.

Locate the sheath fluid container @.
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FILL THE SHEATH FLUID CONTAINER

2-4

IMPORTANT Misleading results could occur if
you contaminate the sheath fluid. Be careful not to
contaminate the sheath fluid. Do not let your
fingers, paper towels, or other objects touch the
inside of the container or the inside of its cap.

4 Remove the cap:

© Unscrew the cap on the sheath fluid
container.

® To avoid contaminating the sheath
fluid, lay the cap upside down on the
container.

N
lyy

CAUTION To prevent damage to the instrument,
do not overfill the sheath fluid container. Avoid
spills. Do not tilt the container or remove it from
the drawer to fill it.

9  Position a funnel into the sheath fluid

container.

6  Carefully pour sheath fluid into the

sheath fluid container, filling it just to
the bottom of its neck.
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FILL THE SHEATH FLUID CONTAINER

71  Carefully wipe up any spills.

~

™ @
“KLLLLLU»U'J @
IMPORTANT Misleading results could occur if
you analyze samples without the cap on the —
sheath container. Be sure to put the cap back on = —
the sheath fluid container after you fill it. —
8

Screw the cap back on.

PN 175572B
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2.5

2-6

9

Close the reagent drawer and perform
the VENT THE AIR BUBBLES
procedure.

VENT THE AIR BUBBLES

Perform this procedure:

After you fill the internal sheath fluid
container

After you replace the sheath fluid
filter

When you are troubleshooting and
suspect bubles in the sheath fluid
tubing.

Note:

The vent button @ lets you release
bubbles that are in the sheath filter
and in the tubing for the sheath fluid.

While the reagent drawer is open, the
vent button in the drawer is
deactivated.

You can only vent the air bubbles
when the reagent drawer is closed
and the Cytometer is initializing or in
the Run or Prime mode.
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REPLACE/ADJUST PROCEDURES
VENT THE AIR BUBBLES

1  Proceed as follows:

* If you have just replaced the
sheath fluid or sheath fluid filter,

go to step 3.

* If you are troubleshooting a
problem and you suspect bubbles
in the sheath fluid tubing, go to
step 2.

2  Open the Front Cover.

SHow ME.

3  Initialize the instrument if you just
replaced the sheath fluid or sheath fluid

filter:

OR,

U

Ezz

If you are troubleshooting:

U

PN 175572B
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VENT THE AIR BUBBLES

4  Pressand hold the vent button until the
bubbles in the vent tubing @ are gone.

WARNING Risk of operator injury. To prevent
injury, hold your hands flat on the sides of the
cover. Ensure your fingers are not behind the
cover as you push down and in to close it.

95 Close the Front Cover.
SHow ME.
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2.6  FILL THE CLEANING AGENT CONTAINER

Perform this procedure whenever Cleanse Level Warning or Cleanse Level Error appears.

1 Check if the instrument is currently
displaying the Idle mode:

* If yes (Press Idle Mode button to
initialize appears), go to step 2.

e Ifno, PUT THE CYTOMETER IN
THE IDLE MODE.

|Press Idle Mode buttan ta initialize]

2  Open the Front Cover.
SHow ME.
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3  Pull open the reagent drawer until it
stops.

T

Locate the cleaning agent container @.

IMPORTANT Misleading results could occur if
you contaminate the cleaning agent. Be careful
not to contaminate the cleaning agent. Do not let
your fingers, paper towels, or other objects touch =]
the inside of the container or the inside of its cap.

4  Unscrew the cap on the cleaning agent
container @. To avoid contaminating
the cleaning agent, lay the cap upside
down on the container @.
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CAUTION Risk of damage to the instrument if

you overfill the cleaning agent container. (
Overfilling the cleaning agent container causes —
the cleaning agent to enter the pressurized line. /\ y —
Avoid spills. Do not tilt the container or remove it ik

from the drawer to fill it. :

9 Position a funnel into the cleaning
agent container.

cleaning agent container, filling it just
to the bottom of its neck @.

6 Carefully pour cleaning agent into the %

71  Carefully wipe up any spills.
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8  Screw the cap back on.

9  Check that:

* The sheath filter vent port @ is
above the connector @.

* The tubing is not kinked or
twisted.
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10 Close the reagent drawer.

i

O
3

WARNING Risk of operator injury. To prevent
injury, hold your hands flat on the sides of the
cover. Ensure your fingers are not behind the

cover as you push down and in to close it.

11 Close the Front Cover.
SHow ME.

12 Before running samples:

@ -3 I
to initialize the system.
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2.7 EMPTY THE WASTE CONTAINER

Instructions and graphics are given for both Power Supply configurations.

Empty the waste container when:

* The Waste Full indicator @ appears, or

*  Waste Level Warning or Waste Level
Error appears.

The 4-L waste @ container sits in a bracket on the right side of the Power Supply.

Procedure

1 Check if the instrument is currently ||F'ress Idle Mode butkon ko initialize|
displaying the Idle mode:

» If yes (Press Idle Mode button to
initialize appears), go to step 2.

e Ifno, PUT THE CYTOMETER IN
THE IDLE MODE.

Note: Wait until any instrument
function is done before emptying the
waste container.
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EMPTY THE WASTE CONTAINER

2  Lift the waste container out of its
bracket and swirl it before removing
the cap.

WARNING Risk of biohazardous contamination if
you have skin contact with the waste container, its
contents, and its associated tubing. The waste
container and its associated tubing might contain
residual biological material and must be handled
with care. Clean up spills immediately. Dispose of
the contents of the waste container in accordance
with your local regulations and acceptable
laboratory procedures.

3  Unscrew the cap and lay it on a
leakproof disposable container, such as
a glove or beaker.
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EMPTY THE WASTE CONTAINER

4  Empty the waste container according to
your laboratory's procedures.

Note: Take proper precautions to avoid
spills if you are emptying the waste
container into a sink, drain, or larger
container.

9  Putabout 400 mL of high-quality,
fragrance-free bleach @ (5% or 6%

sodium hypochlorite - available
chlorine) in the waste container to f

cover the bottom of the container.
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EMPTY THE WASTE CONTAINER

Replace the cap and securely tighten.

Note: Properly dispose of the leakproof
disposable container used in step 3
after you screw the cap back on the
waste container.

Wipe the bracket with a paper towel
moistened with a 10% bleach solution,
and then return the container to the
bracket.
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2.8

2-18

The system automatically performs an
initialization cycle if you emptied the
waste container after the Waste Full
indicator appeared.

Note: If you emptied the waste
container before the Waste Full
indicator appeared:

REPLACE THE SHEATH FLUID FILTER

Replace the 0.2-pm sheath fluid filter @:

Every 6 months.

or

Whenever the sample flow rate is too
high (repeated Data Rate Warning or
System Pressure Error messages
appear).

Procedure

@ -3 R
to initialize the system.

Il

Il

1

Check if the instrument is currently
displaying the Idle mode:

e If yes (Press Idle Mode button to

initialize appears), go to step 3.

e Ifno, PUT THE CYTOMETER IN
THE IDLE MODE.

|Press Idle Mode buttan ta initialize]
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2  Open the Front Cover.
SHow ME.

3 Open the reagent drawer. Locate the
sheath filter @.

I

=
|

PN 175572B
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2-20

4  Undo the flexible strap holding the
sheath fluid filter.

CAUTION Risk of damage to the instrument if
you do not install the sheath fluid filter correctly.
It allows fluid to flow in one direction only. Make
sure you install the new sheath fluid filter
correctly.

9  Pick up the old sheath fluid filter, and
notice how the three tubes are
connected @, @, ®. Turn the filter and
notice the direction of the arrow on it.

6  Get the new filter and hold it with the
arrow going in the same direction as
the arrow on the old filter.

Note: In the next step, immediately
install the new filter to avoid spills.

7 Disconnect and reconnect each tube to

the new filter, one at a time, in this
order: @, @ ©.

Each tube is disconnected by pushing
in on the metal clip on the
connector @.

When reconnected, the connectors
snap into place.
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REPLACE THE SHEATH FLUID FILTER

8 Discard the old sheath fluid filter.

9  Wipe up any spills, and then put the
filter in the drawer.

10 Check that:

* The vent port @ is above the
connector @.

* The tubing is not kinked or
twisted.

11 Reattach the flexible strap that holds
the sheath fluid filter.
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12 Close the reagent drawer and perform
the VENT THE AIR BUBBLES
procedure.

WARNING Risk of operator injury. To prevent
injury, hold your hands flat on the sides of the
cover. Ensure your fingers are not behind the

cover as you push down and in to close it.

13 Close the Front Cover.

SHow ME.

14 Record that the sheath fluid filter was Every 6 Months
replaced on the electronic Maintenance Replace Sheath Filer .
Log.
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2.9 REPLACE THE SAMPLE PROBE AND SAMPLE PICKUP TUBING

Replace the sample probe and sample pickup tubing when:

* The sample probe is bent. To see a video of this condition, click SHOW ME.

* The sample probe leaks. To see a video of this condition, click SHow ME.

* There is erratic sample flow or no sample flow from the sample probe.
Click SHOW ME for an overview.

1 Power the Cytometer OFF.

2 Open the MCL cover.

Note: If a carousel is present, remove it.

3  Open the Front Cover.
SHow ME.
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2-24

Remove the Front Left Side Panel:

@ Unscrew the two screws that attach
the left side panel to the front frame.

® Snap off the left side panel.
SHow ME.

Unscrew the sample pickup tubing
connector from the bottom of the flow
cell compartment.

To view how to remove the sample
probe and sample pickup tubing, click
SHow ME.
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6  Pull the sample pickup tubing out
through the left (MCL) side of the
instrument.

7  Remove the clip from the sample
probe. Retain the clip.
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REPLACE THE SAMPLE PROBE AND SAMPLE PICKUP TUBING

8  Lift the sample probe up and out of its
holder.

WARNING Risk of biohazardous contamination if
you have skin contact with the sample pickup
tubing. The sample pickup tubing might contain
residual biological material and must be handled
with care. Clean up spills immediately. Dispose of
the sample pickup tubing in accordance with your
local regulations and acceptable laboratory
procedures.

9 Discard the old sample pickup tubing
and probe assembly in accordance with
your local regulations and acceptable
laboratory procedures.
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REPLACE THE SAMPLE PROBE AND SAMPLE PICKUP TUBING

10 Ensure that the rubber washer @ and
O-ring @ are positioned correctly on
the new sample probe.

To view how to install the sample probe
and sample pickup tubing,
click SHow ME.

11 Thread the sample pickup tubing
through the instrument.
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12 Insert the new sample probe into the
sample probe holder.

13 Guide the sample probe tip into the
MCL sample head.

14 Insert the clip removed in step 7 into
the groove on the sample probe.
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REPLACE/ADJUST PROCEDURES 2
REPLACE THE SAMPLE PROBE AND SAMPLE PICKUP TUBING

IMPORTANT Risk of erroneous results if the flow
cell is misaligned. Overtightening the connector
from the sample pickup tubing to the flow cell can
cause misalignment of the flow cell. Only screw
on the sample pickup tubing connector “finger
tight.”

19 Screw on the connector from the
sample pickup tubing to the bottom of
the flow cell compartment until it is
“finger tight.”

16 Replace the Front Left Side Panel.
© Snap on the left side panel.

® Screw in the two screws to attach the
left side panel to the front frame.

SHow ME.
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REPLACE THE SAMPLE PROBE AND SAMPLE PICKUP TUBING

WARNING Risk of operator injury. To prevent
injury, hold your hands flat on the sides of the
cover. Ensure your fingers are not behind the
cover as you push down and in to close it.

17 Close the Front Cover.
SHow ME.

18 Close the MCL cover.

19 Power the Cytometer Only ON or
Power the Cytometer and CXP
Software ON.

» U
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REPLACE THE MCL SAMPLE HEAD

21  After the prime cycle is done:

Y.

2.10 REPLACE THE MCL SAMPLE HEAD

Use this procedure when:

* Liquid from the cleaning adaptors does not draw up properly.
* Cleaning the sample head does not fix your excessive carryover problem.
* Numerous Sample Pressure Error or MCL Tube Up/Down Error messages occur.

To see a video presentation of the main steps of this procedure, click SHOW ME.

1 Power the Cytometer OFF.

2 Open the MCL cover.

Note: If a carousel is present, remove it.
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REPLACE THE MCL SAMPLE HEAD

3  Open the Front Cover.
SHow ME.

4 Remove the Front Left Side Panel:

© Unscrew the two bolts that attach
the left side panel to the front frame.

® Snap off the left side panel.
SHow ME.
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REPLACE THE MCL SAMPLE HEAD

9 Usea0.050 in. Allen wrench to loosen
the side @ and front @ setscrews on the
sample head.

SHow ME.

6  Pull off the sample head.

PN 1755728
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REPLACE THE MCL SAMPLE HEAD

2-34

7  Pull the sample head and tubing
through the instrument behind the
frame.

8 Loosen the thumbscrew at the side of
the pneumatic drawer.

9 Pull out the pneumatic drawer so you
can access the tubing manifold.

10 Loosen the thumbscrew holding the

upper tubing manifold.

Note: You might find it easier to
unscrew the thumbscrew with a
screwdriver.
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REPLACE THE MCL SAMPLE HEAD

11 Pull off the tubing manifold.

WARNING Risk of biohazardous contamination if
you have skin contact with the sample head and
its tubing. The sample head tubing might contain
residual biological material and must be handled
with care. Clean up spills immediately. Dispose of
the sample head and tubing in accordance with
your local regulations and acceptable laboratory
procedures.

12 Discard the old sample head and tubing
assembly in accordance with your local
regulations and acceptable laboratory
procedures.
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REPLACE THE MCL SAMPLE HEAD

13 Place the new tubing manifold into the
bracket in the pneumatic drawer and
tighten the thumbscrew.

Note: You might find it easier to screw
in the thumbscrew with a screwdriver.

To view how to install the MCL sample
head, click SHow ME.

14 Route the sample head through the
instrument.
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REPLACE THE MCL SAMPLE HEAD

15 Slide the pneumatic drawer in and
tighten the thumbscrew.

16 Position and hold the sample head up
against its bracket.

17 Tighten the side @ setscrew first.

Then tighten the front @ setscrew.
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REPLACE THE MCL SAMPLE HEAD

18 Replace the Front Left Side Panel:
© Snap on the left side panel.

@ Screw in the two bolts to attach the
left side panel to the front frame.

SHow ME.

WARNING Risk of operator injury. To prevent
injury, hold your hands flat on the sides of the
cover. Ensure your fingers are not behind the

cover as you push down and in to close it.

19 Close the Front Cover.
SHow ME.
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REPLACE THE MCL SAMPLE HEAD

20 Close the MCL cover.

21 Power the Cytometer Only ON or
Power the Cytometer and CXP
Software ON.
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ADJUST THE SYSTEM PRESSURE

2.11  ADJUST THE SYSTEM PRESSURE

* Adjust the system pressure if the System Pressure gauge is not reading 30 +2 psi.

* Daily Startup describes how to check the System Pressure gauge reading on the Power
Supply.
Instructions and graphics are given for both Power Supply configurations.

1 Open the Power Supply front door.
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ADJUST THE SYSTEM PRESSURE

2  Locate the Pressure Adjust knob @.
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3  Pull the collar around the Pressure
Adjust knob out toward you.
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ADJUST THE SYSTEM PRESSURE

4  Adjust the pressure to 30 =2 psi.
@ To decrease, turn to the left.

® To increase, turn to the right.

95  Push in on the collar to lock it into
place.
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REPLACE THE OPTICAL FILTER PLATE

2.12 REPLACE THE OPTICAL FILTER PLATE

Replace the optical filter plate when you need to use a different filter configuration for a
different application.

Remove the Optical Filter Plate
Click SHOW ME for an overview.

IMPORTANT Risk of incorrect readings from a contaminated filter if you wear gloves with powder to
perform this procedure. Powder from the gloves can contaminate the filter and cause incorrect readings.
Wear powder-free gloves whenever you are working with any optical filter components.

1 Wear powder-free gloves to perform this procedure.

2  Power the Cytometer OFF.

3  Open the Front Cover.
SHow ME.
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REPLACE THE OPTICAL FILTER PLATE

4  Pinch down on both release clips of the
optical area cover. Slide the cover
forward and lift it off.

5 Usea3/16 in. Allen wrench to unscrew
the bolt in the middle of the optical
filter plate.
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REPLACE THE OPTICAL FILTER PLATE

6  Lift the optical filter plate up and off.
Set this optical filter plate aside.
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REPLACE/ADJUST PROCEDURES
REPLACE THE OPTICAL FILTER PLATE

Install the Optical Filter Plate
Click SHow ME for an overview.

IMPORTANT Risk of incorrect readings from a contaminated filter if you wear gloves with powder to
perform this procedure. Powder from the gloves can contaminate the filter and cause incorrect readings.
Wear powder-free gloves whenever you are working with any optical filter components.

1 Wear powder-free gloves to perform this procedure.

2  Place the new optical filter plate into
the instrument.

Check that it is firmly seated.
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REPLACE THE OPTICAL FILTER PLATE

3  Usea3/16 in. Allen wrench to screw in
the bolt in the middle of the optical
filter plate.

IMPORTANT Risk of incorrect results. If the
optical area cover is not replaced securely, there
will be no fluorescence signals but there will be FS
and SS signals. Be sure the optical area cover
snaps into position.

4  Slide the optical area cover back into
position until it snaps into place.

WARNING Risk of operator injury. To prevent
injury, hold your hands flat on the sides of the
cover. Ensure your fingers are not behind the
cover as you push down and in to close it.

5 Close the Front Cover.
SHow ME.

PN 175572B 2-47



REPLACE/ADJUST PROCEDURES
REPLACE A FILTER IN THE OPTICAL FILTER PLATE

6  Power the Cytometer Only ON or
Power the Cytometer and CXP
Software ON.

2.13 REPLACE A FILTER IN THE OPTICAL FILTER PLATE

Perform this procedure when:

*  When there is a loss of signal power - replace the old filter with a new filter of the same
type.

*  When you are running a different application and need a different filter in that filter
holder.

IMPORTANT Risk of incorrect readings from a contaminated filter if you wear gloves with powder to
perform this procedure. Powder from the gloves can contaminate the filter and cause incorrect readings.
Wear powder-free gloves whenever you are working with any optical filter components.

1 Wear powder-free gloves to perform this procedure.

2  Remove the Optical Filter Plate.

To see a video presentation of the main
steps of how to remove the optical filter
plate, click SHow ME.
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REPLACE A FILTER IN THE OPTICAL FILTER PLATE

3  Turn the optical filter plate on its side.

To see a video presentation of the main
steps of how to remove a filter, click
SHow ME.

4  On the underside of the optical filter
plate, locate the screw that holds the
filter holder to be removed.

5  Use a9/64 in. Allen wrench to remove
the screw that holds the filter to be
replaced from the optical filter plate.
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REPLACE A FILTER IN THE OPTICAL FILTER PLATE

6  Use the special tool provided to loosen
the metal ring on the filter holder.

Note: You might find it easier to finish
loosening the metal ring by turning it
with your gloved fingers.

7  Insert the tool into the metal rings two
slots and turn to the left.

8 Remove the metal ring and the filter.

9  Orient the new filter correctly and
insert the filter into the filter holder.

e For BCI filters:

Position the filter into the filter
holder so the arrow points to the
metal ring.

¢ For non-B(I filters:

See step 10 for how to determine
correct orientation.

To see a video presentation of the main
steps of how to install a filter, click
SHow ME.
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REPLACE A FILTER IN THE OPTICAL FILTER PLATE

10 Determine which is the coated side @
of a non-BClI filter:

a.

Take the eraser end of a pencil and
hold it close to the filter, near its
edge.

Look at the two reflections, dark-
and light-colored, of the pencil.
Turn the filter over and repeat
steps a and b.

The side where the pencil touches
the dark-colored reflection is the
coated side @.

The uncoated side @ shows the
pencil touching the light-colored
reflection.

The coated side @ should face the
metal ring when you insert it.

11

Place the metal ring over the filter in
the filter holder.
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REPLACE A FILTER IN THE OPTICAL FILTER PLATE

12 Insert the special tool into the metal
ring’s two slots and turn to the right to
tighten.

Note: You might find it easier to begin
tightening the metal ring by turning it
with your gloved fingers.

13 Orient the filter holder and filter
correctly:

* If there are arrows on the optical
plate, place the side of the filter
holder with the metal ring in the
same direction as the arrow.

* If there are no arrows on the
optical plate, place the filter holder
so the metal ring faces in the
direction where the light should

go.
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REPLACE/ADJUST PROCEDURES 2
REPLACE A FILTER IN THE OPTICAL FILTER PLATE

14 Insert the filter holder into the optical
filter plate and screw in the holding
SCrew.

15 Install the Optical Filter Plate into the
instrument.

To see a video presentation of the main
steps of how to install the optical filter
plate, click SHow ME.

Note: If you replaced a damaged filter
with the same type of filter, check that
you retrieve similar
autostandardization mean intensity
values with the new filter.
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2.14 POSITION THE FIELD STOP

*  You can change the angle of forward
scatter (FS) light collection from
1-19° to 1-8° by putting the Field
Stop into position.

* Put the Field Stop into position
(1-8°) for better separation of cell

populations in samples with a lot of
debris.

* Position the Field Stop by sliding a
spring-loaded knob along a track.

»  When the knob is at the left end
of its track, the Field Stop is
used. The angle of light
collection is reduced to 1-8°.

» When the knob is at the right
end of its track, the Field Stop is
not used. The angle of light
collection is from 1-19°.

Procedure

Perform this procedure when you need to change the field stop postion to use a different
angle of forward scatter.

1 Open the Front Cover.
SHow ME.
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To put the Field Stop into position and
use the 1-8° angle of FS light collection:

e Slide the knob all the way to the
left end of its track.

* Push it in to lock it into position.

To move the Field Stop so it is not in
use (1-19° angle of FS light collection):

¢ Pull out on the knob to unlock it.

*  Guide the knob to the right end of
its track.

1-19°

WARNING Risk of operator injury. To prevent
injury, hold your hands flat on the sides of the
cover. Ensure your fingers are not behind the

cover as you push down and in to close it.

4 Close the Front Cover.

SHow ME.
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2.15 RESET THE CIRCUIT BREAKERS

Perform this procedure when:

* The unit does not go to Ready when you turn the power ON.
* There is no compressor sound from the Power Supply when there normally should be.

Instructions and graphics are given for both Power Supply configurations. Use the procedure
(Procedure 1 or Procedure 2) that corresponds to your Power Supply configuration.

If you have the Universal Power Supply
configuration:

Follow Procedure 1 to reset the
power.

If you have the Voltage-specific Power
Supply configuration:

Follow Procedure 2 to reset the
circuit breaker(s).

2-56 PN 1755728



REPLACE/ADJUST PROCEDURES 2
RESET THE CIRCUIT BREAKERS

Procedure 1

1 Check the indicators @ through the
front door of the Power Supply.

2 Open the Power Supply front door.
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RESET THE CIRCUIT BREAKERS

3  If the indicators are off (dark), reset the
circuit breakers.

Put the main switch in the 0 position to
turn the power supply off.

4  Reset the circuit breakers by pressing
all 26 buttons — /_\ \ ~
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RESET THE CIRCUIT BREAKERS

9 Put the main switch in the 1 position to
turn the power supply back on.
A 0 oo s i
-— '|r-'?1|. '|ri:éi1|. i
1 I i
L —
6  Power the Cytometer OFF and then

Power the Cytometer and CXP
Software ON.
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RESET THE CIRCUIT BREAKERS

2-60

Procedure 2

1 Open the Power Supply front door.

2  Check the indicators @ on the front of
the Power Supply.

a.

If any indicator is off (dark),
proceed to step 3 to reset the
appropriate circuit breaker.

If no indicator is dark, check if the
power switch at the back of the
Power Supply is OFF (0). If it is,
turn it ON (1) and proceed to
step 5.

=

D i|rl|l1|-

WATER H
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REPLACE/ADJUST PROCEDURES 2
RESET THE CIRCUIT BREAKERS

3  Find the circuit breaker that corresponds to the dark indicator:

System MCL

Power Indicator Circuit Breaker Power Indicator  Circuit Breaker
+5V 5 VOLTS +5V MCL 5 VOLTS
+15V 15 VOLTS +12V MCL 5 VOLTS
-15V 15 VOLTS -12v MCL 5 VOLTS
+24V 24 VOLTS +24V MCL 24 VOLTS

4  Put the circuit breaker in the 0
position, and then return it to the 1
position.

9 Power the Cytometer OFF and then
Power the Cytometer and CXP
Software ON.
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ADJUST THE HENE LASER

6  On the back of the Power Supply, turn

OFF (0) the system and then turn it
back ON (1) to finish resetting the
instrument.

2.16 ADJUST THE HENE LASER

Use this procedure to make minor adjustments only to the HeNe laser.

2-62

D

L

DD
d
= e

Note: If your instrument has an optional red solid-state laser, call your Beckman Coulter

Representative for any adjustments.

Adjustments should be made when the FL4 mean channel values of the integral signal

intensity:

* Vary more than +5% from the Mean integral signal channel within 24 hours, or

e Vary more than +5% over a 7 day period.

1 Select the HeNe alignment protocol
which contains the F1L4 Lin/AUX (FL4
Peak) histogram gated on the
Flow-Check 675 fluorospheres:

o @ File » Protocol.

* Select HeNe Alignment.PRO from the
list of protocols.

N |

2| ]
Laoak in: I@AcquisitionProtocol j & I‘j‘ ,

cleanse di water PRO

5 FL3 Comp.PRO
5 FL4 Comp.PRO
5 FLS Comp.PRO

HeMe Alignment. PRO
QC 1L Flow-Check,PRO
Cleanse - Bleach.PRO QC 2L Flow-CheckPRO
Cleanse - Water PRO
cleanse bleach,PRO

1 [+

Open I
j Cancel |

File name: |HeNe Alighment

Files of type: IProtocoI Files [*.pra)
4

PN 175572B




PN 175572B

REPLACE/ADJUST PROCEDURES

ADJUST THE HENE LASER

Place a sample tube containing
Flow-Check 675 fluorospheres (or the
same Flow-Check fluorospheres
mixture that you used for your daily
QQ) into the carousel.

Put the carousel into the MCL sample
loader.

Close the MCL cover.

Enter the Carousel No. in the Worklist.
The tube Location number
automatically appears.

Carousel
Ho.

Location

56

7

5 @ to start acquisition.
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ADJUST THE HENE LASER

2-64

@ =
Acq. Seb i
6 Setup Mode on the Cytometer e |P"Tfe°‘°'8| Compensatin|
.. [~ ACqQUIZITON e = m— .
Control Acquisition Setup Tab. IEMEI BEsiilics ] [ 4
300 FS E5
Max events % OFF
FL1 OFF
oy FL2 OFF
Drive Space(MB]: 249609 | |FL3 OFF
PR T— FL4 OFF
.c:qulsmon mode: FLs OFF
Live Gate AL OFF
IUngated 'l e
c =
QuickCOMP
™ DuickSET Barameters... |
™ Baseline Offset — Fed Laser Shutter
Dots ) Lazer Disabled
|5DD % [ azer Enabled
Cloze I Help
1  View the rectangular regions in the FL4 =1
Lin/AUX (FL4 Peak) plot. §
When the HeNe laser is out of T Target
alignment, the fluorospheres i
population typically appears in the | D
lower left portion of the plot. g u
_| Reference
- o TR
FLALin
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ADJUST THE HENE LASER

8 Selectand drag the Reference region to [9][FcsT51 FL# LingAux N =IE
center it on the fluorospheres
population. 4

1023

Target

This is just a visual aid to reference the ]
fluorospheres population location prior D
to adjustment.

Reference

1

AUX
|

o T T T T T T T 1023

FL4 Lin

9  Open the cover to access the HeNe
laser.
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ADJUST THE HENE LASER

10 Turn the HeNe laser’s front adjustment
knob clockwise to move the
fluorospheres population up and to the
right.

If the population starts to move down,
turn the knob counterclockwise.

See step 11 for details.

LASER RADIATION
AVOID EXPOSURE TO BEAM

CLASS 3B LASER PRODUCT (IEC)
CLASS Illb LASER PRODUCT (CDRH)

'AVOID EXPOSURE
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ADJUST THE HENE LASER

11 Move the fluorospheres population as

high up and to the right as possible into
the Target region (as shown).

If you continue to turn the knob after
the fluorospheres population moves as
high up and to the right as it can, the
fluorospheres population starts to
move back down. To return to the best
position, turn the knob in the other
direction.

Note: If you cannot move the
fluorospheres population into the
Target region:

* Turn the HeNe laser’s front
adjustment knob to return the
fluorospheres population into the
Reference region.

* Call your Beckman Coulter
representative.

[ ®][FCE75] FL4 Lin,

AUX

1023

/AUX

=10l x|

Target

Reference

[]

FL4 Lin

" 1023

12 Close the cover over the HeNe laser.
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13 Deselect Setup Mode on the Cytometer
Control Acquisition Setup Tab.

Acquisition stops when the count is
reached.

14 When the processing is done, remove
the carousel.

Close the MCL cover.

15 Run the appropriate QC Flow-Check
protocol before running samples.
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MAINTENANCE AND SERVICE LOGS

A.1  INTRODUCTION

The Report Generator contains two log screens you can use to record maintenance and
service activities. Use the MAINTENANCE LOG to record daily and periodic maintenance.
Use the SERVICE LOG to record service conditions noted and actions taken.

A.2  MAINTENANCE LOG

The Maintenance Log lists actions that need to be performed and how often they are needed.

zJ
File Admin Legend Help

Facility MNarne:
Daily Starup | B
“Water Trap

Air Filber

Wacuum Filker

Cytometer Serial Number: AES0004

System Yacuum

System Press

Yacumm Trap

Daily Shutdown

Routine Cleaning

Sample Head/Probe

Wacuum Line Clean

Weekly

Clean Air Filters A
Clean MCL Head/Probe A
Monthly

Clean Sheath Tank

Every 60 days

Clean Cleanse Tank

Every 6 Months

Feplace Sheath Filter

As Needed

Clean Yacuum Trap

Additional

JL|

MAY 2004 c[ 12 3 45 6 7 8 3101112131415 16 17 1813 20 21 22 23 24 25 26 27 28 23 30 31 J

\
o o o

55720558

The instrument serial number and facility name are displayed at the top.

The boxes corresponding to the current day's date are highlighted. These are the only ones that may
be selected by a user.

The dates are shown across the bottom. The most recent month is shown by default.

o oo

Arrow buttons on the bottom line can be used to show other months.
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MAINTENANCE AND SERVICE LOGS
MAINTENANCE LOG

Menu Options

The following menu items are available.

File Menu
The File menu has 3 options.

*  Print - Prints the Maintenance Log of the current month.

function.

e Save - Saves a new entry on the Maintenance Log. [ =8

* Exit - Exits the Maintenance Log.

Admin

Prompts for the CXP Administrator password. E

Legend

=]

performs the same

performs the same function.

performs the same function.

performs the same function.

Displays a legend that shows the list of user names and the corresponding color used for the

M performs the same function.

visual display.

Help

E2

Displays the Maintenance Log help.

Using The Maintenance Log

performs the same function.

The system automatically assigns letter "A" to the Administrator and assigns a unique color
and letter to all other users. The color assignment is used for visual display and the letter
assignment is used for printing. The letter legend is printed with the log. The pre-assigned
letter "A" for Administrator is used for both the visual display and the printout.

User Entry

Double-click on a box for the current

S Weekly
date to indicate that you have performed -
. . Clean Air Filters .
the specified action.
Clean MCL Head/Probe [}

You can erase your own entry for the
current date by clicking on the box
again. You cannot change entries for
other users or previous dates.

A-2
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MAINTENANCE LOG

To enter a comment on any of the boxes, Weekly
right-click on the box and select

Clearn Air Filkers
Insert Comment.
Clean MCL Head/Probe i
The presence of a comment in a box is
indicated by a small red square in the
upper right-hand corner of the box and
is visible on the printout. The CXP User
ID precedes the comment.
Administrator Entry
@
TO log in, E and enter the CXP Administrator Pazsword: |$$$$$$$$1
Admin password. ok_|
Admin will log out when you exit the
screen.
on any empty box and the letter A Clean Air Filters .
is displayed in the box. Clean MCL Head/Probe | 4 | -

Right click on any box and @ Delete to
erase it and a hyphen '-' is displayed in
the box.

To enter a comment on any of the boxes, right-click on the box and select Insert Comment.
If the box already contains a comment and the Administrator adds a comment, the
previous comment is replaced and the letter A precedes the comment however, the
original user color designation remains in the box.
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A-4

The Administrator can add a task to the bottom of the fixed list by clicking on one of the
empty rows. The task is added to the section starting with the current month. A total
number of 5 additional task rows are available.

The Administrator can edit or delete any task that was added. Default (system-defined)
tasks may not be edited or deleted.

To edit an added task, @ on the task and make the desired changes.

To delete an added task, @ on the task and press (Delete).

The task is deleted from the current month going forward. A task may not be deleted if
there are entries for it in the current month.
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A.3  SERVICE LOG

=101
StartDate| [p5/14/2003 —1 |
End Date: Wr>e
Date User ID Condition Noted Date User 1D Action Taken g
1 |5/13/2004  techcomm  New software announced 5/14/2004  techcomm  Installed new software
| 2 |
E
| 4 |
| 5 |
| 6 |
| 7 |
| 8 |
| 9 |
| 10 |
K
| 12 |
[ 13 ]
| 14 |
| 15 |
| 16 |
|17 |
| 12 |
| 13 |
ER
| 21 |
| 2 |
)
| 24 |
i o
4 »
4

55720568

Date that the Condition Noted entry was made.
The instrument serial number and facility name are displayed at the top.

User who made the entry. This field is non-editable and it is filled in automatically by the system when
the Date is entered.

Enter text (up to 255 characters) to describe the condition noted.
The second Date applies to the Action Taken entry and tracks the date of the action.

Applies to the User who made the Action Taken entry. This field is non-editable and it is filled in
automatically by the system when the Date is entered.

Enter text (up to 255 characters) to describe the action taken.

@90 0006 o0 0C

The Start and End Dates are used for visual display - the log will automatically scroll to the time period
selected.
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A-6

Menu Options

The following menu items are available.

File Menu
The File menu has 3 options.

*  Print - Prints the Service Log of the current month. ﬁ
e Save - Saves a new entry on the Service Log.

* Exit - Exits the Service Log.

Help

Display the Service Log help.

Using The Service Log

E2

performs the same function.

performs the same function.

performs the same function.

performs the same function.

The Service Log is a scrollable grid with entries in chronological order.

Enter Condition Noted

1 Double-click the Date column and select the date on the calendar corresponding to the

condition noted.

2 Double-click the Condition Noted field and type the text describing the condition noted.

—
3 @ M| to save the Service Log.

Enter Action taken

1 Double-click the Date column and select the date on the calendar corresponding to the

action taken.
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2  Double-click the Action Taken field and type the text describing the action taken.

—
3 @ M| to save the Service Log.

Start Date: and End Date:

Use these fields to display the entries between Start Date and the End Date. The log displays
the time period selected. The dates are based on Condition Noted dates only.
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Numerics

6 month procedures
replace the sheath fluid filter, 2-18
See also schedule
60 day procedures
clean the cleaning agent container, 1-25
See also schedule

A

about this manual, ix
acridine orange
how to clean after using, 1-37
test for residual stain, 1-41
adaptor, cleaning
how to use, 1-44
illustration, 1-44
adjustment procedures, 2-1
circuit breakers, resetting, 2-56
field stop, positioning, 2-54
HeNe laser, 2-62
system pressure, 2-40
air bubbles
venting, 2-6
air filter
See also filters
Awaiting Sample, 1-36

bleach
add to waste container, 2-16
how to prepare cleaning solution, 1-38
load cleaning solution in carousel, 1-39
load for use in cleaning panel, 1-39
used in routine cleaning, 1-38
used in sample head/probe cleaning, 1-42
bottle, waste
See waste container
bubbles
venting, 2-6
buttons
vent, 2-6

C

circuit breakers
indicators, 2-61
location, 2-58, 2-61
resetting, 2-56

PN 175572B

cleaning
schedule, 1-1
cleaning adaptor
how to use, 1-44
illustration, 1-44
cleaning agent
container, cleaning, 1-25
container, when to clean, 1-25
filling the container, 2-9
See also cleaning agent container
cleaning agent container
cleaning, 1-25
filling, 2-9
location, 2-10
cleaning panel
how to select, 1-39
cleaning procedures, 1-1
air filters, 1-2
bleaching, 1-38
cleaning agent container, 1-25
MCL sample head, daily, 1-42
MCL sample head, weekly, 1-47
routine, 1-38
sample probe, daily, 1-42
sample probe, weekly, 1-47
sampling system, when to clean, 1-37
sheath fluid, 1-23
vacuum line, 1-44
vacuum trap, 1-31
cleaning solution
how to prepare, 1-38
routine, how to load into the carousel, 1-39
vacuum line, how to load into the carousel, 1-44
See also bleach, cleaning agent
Cleanse.PNL
how to select, 1-39
close
front cover, 1-13
left side panel, 1-16
MCL lid, 1-17
computer
power off, 1-51
power on, 1-51
container
reagent, filling with cleaning agent, 2-9
reagent, filling with sheath fluid, 2-2
reagent, replacing, 1-28
waste, capacity, 2-14
waste, emptying, 2-14
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INDEX

conventions
used in the manual, x
Coriphosphine-O
how to clean after using, 1-37
test for residual stain, 1-41
COULTER CLENZ
See cleaning agent
covers
front, how to open, 1-11
instrument, how to open, 1-11
left side panel, how to remove, 1-15
MCL lid, how to open, 1-17
optical area, how to remove, 2-44
Cytometer
power off, 1-51, 1-53
power on, 1-51, 1-52

D

daily procedures
clean the MCL sample head, 1-42
clean the sample probe, 1-42
clean the vacuum line, 1-44
routine cleaning, 1-38
See also schedule
distilled water
in solution for routine cleaning, 1-38

in solution for sample head/probe cleaning, 1-42

in vacuum line cleaning, 1-44
documentation for your instrument
about your special procedures and
troubleshooting manual, ix
conventions used, x
introduction to your manuals, ix
using the manuals, ix

E

empty the waste container, 2-14
ethidium bromide
how to clean after using, 1-37
test for residual stain, 1-41

F

FC 500
manuals, hard-copy, ix

field stop
change light collection angle, 2-54
how to position, 2-54

INDEX-2

when to use, 2-54
filling
cleaning agent container, 2-9
sheath fluid container, 2-2
filter plate
See optical filter plate
filters
air, cleaning, 1-2
air, location, 1-2
air, when to clean, 1-2
optical, how to orient into holder, 2-50
optical, non-BCI, 2-51
optical, replacing, 2-48
sheath fluid filter, location, 2-18
sheath fluid filter, replacing, 2-18
fluorescein diacetate
how to clean after using, 1-37
test for residual stain, 1-41
forward scatter (FS)

how to change angle of light collection, 2-54

ES

See forward scatter
funnel

use to fill reagent container, 2-4, 2-11
Fura 3

how to clean after using, 1-37

test for residual stain, 1-41

G

gloves, powder free

use when working with filters, 2-46
graphics

for illustration only, xi

H

Helium Neon laser
See HeNe laser
HeNe Alignment.PRO
when to use, 2-62
HeNe laser
how to adjust, 2-62
when to adjust, 2-62

idle mode
how to access, 1-18
when it is needed, 1-18
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indicators 0

circuit breaker, chart, 2-57, 2-60

circuit breaker, location, 2-57, 2-60 front cover, 1-11

sheath fluid low, 2-2 left side panel, 1-15

waste full, 2-14 MCL lid, 1-17
instrument

covers, how to open, 1-11
introduction to your manuals, ix
IsoFlow sheath fluid

See sheath fluid

open

optical area
cover, how to remove, 2-44
how to access, 2-43
optical filter plate
how to install, 2-46
how to remove, 2-43
L illustration, 2-46
optical filters

laser ;
adjust the HeNe, 2-62 See filters
left side panel
how to remove, 1-15 P

light collection

panels
change the angle of FS, 2-54

Cleanse.PNL, 1-39

lights o how to select cleaning panel, 1-39
See indicators See also covers
log on, 1-51

pickup tubing
See sample pickup tubing
M position the field stop, 2-54
powder-free gloves
use when working with filters, 2-46
Power Supply
air filters, location, 1-2, 1-7
circuit breaker indicators, location, 2-57, 2-60
circuit breakers, location, 2-58, 2-61
introduction to your manuals, ix power coFds, 1ocat19n, 1-5,1-10
using the manuals, ix power switch, location, 2-62
MCL lid pressure adjust knob, location, 2-41
vacuum trap, location, 1-31
power switch
Power Supply, location, 2-62
pressure
system, adjusting, 2-40
system, correct range, 2-40

Maintenance Log, A-1
manuals for your instrument
about your special procedures and
troubleshooting manual, ix
conventions used, x
how to use, ix

how to open, 1-17
MCL sample head
cleaning, daily, 1-42
cleaning, weekly, 1-47
location, 1-43
replacing, 2-31

when to clean, 1-37, 1-47 pressure adjust knob
mode location, 2-41
idle, 1-18 probe, sample
, See sample probe

monthly procedures
clean the sheath fluid container, 1-23
See also schedule

Multi-Tube Carousel Loader (MCL)
See MCL

procedures
adjustment. See adjustment procedures
cleaning. See cleaning procedures
replacement. See replacement procedures
propidium iodide
how to clean after using, 1-37
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test for residual stain, 1-41
protocols
HeNe alignment, 2-62

R

reagent containers
about, 2-1
capacity, 2-2
filling with cleaning agent, 2-9
filling with sheath fluid, 2-2
location, 1-19
removing, 1-18
sensor location, 1-21, 1-28
reagent drawer
location, 1-19, 2-1
reagents
containers, replacing, 2-1
replacing, 2-1

See also cleaning agent and sheath fluid

Reference region

HeNe laser adjustment, 2-65
regions

HeNe Reference region, 2-65

HeNe Target region, 2-67
removing

optical filter plate, 2-43

reagent containers, 1-18
replacement procedures, 2-1

cleaning agent, 2-9

MCL sample head, 2-31

optical filter, 2-48

optical filter plate, 2-43

reagent containers, 1-28, 2-1

sample pickup tubing, 2-23

sample probe, 2-23

schedule, 2-1

sheath fluid, 2-2

sheath fluid filter, 2-18
reporting units

shown in US unit format, xi
residual stain

from old cleaning solution, 1-38

testing for, 1-41

S

sample head
See MCL sample head
sample pickup tubing

INDEX-4

how to replace, 2-23
when to replace, 2-23
sample probe
bent, 2-23
cleaning, daily, 1-42
cleaning. weekly, 1-47
clip, location, 2-25
how to replace, 2-23
leaking, 2-23
no or erratic sample flow, 2-23
O-ring, location, 2-27
rubber washer, location, 2-27
when to clean, 1-37, 1-47
when to replace, 2-23
sampling system
when to clean, 1-37
schedule
cleaning, 1-1
replacement, 2-1
sensors
reagent containers, 1-21, 1-28
Service Log, A-5
sheath fluid
container, cleaning, 1-23
container, filling, 2-2
in solution for routine cleaning, 1-38
in solution for sample head/probe cleaning, 1-42
low indicator, 2-2
replacing, 2-2
use in routine cleaning, 1-38
used to clean reagent containers, 1-23, 1-25
See also filters, reagents, and sheath fluid
container
sheath fluid container
cleaning, 1-23
filling, 2-2
location, 2-3
when to clean, 1-23
sheath fluid filter
See filters
shutdown
cleaning before daily shutdown, 1-37
6 month procedures
replace the sheath fluid filter, 2-18
See also schedule
60 day procedures
clean the cleaning agent container, 1-25
See also schedule
special procedures and troubleshooting manual
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information organization, ix
using the manual, ix
special tool
used to replace optical filter, 2-50
stains

residual, from old cleaning solution, 1-38

residual, testing for, 1-41
vital, how to clean after using, 1-37
vital, test for residual, 1-41
system pressure
adjusting, 2-40
correct range, 2-40

T

Target region

HeNe laser adjustment, 2-67
thiazole orange

how to clean after using, 1-37

test for residual stain, 1-41
tools

special, used to replace optical filter, 2-50

tubing
See also sample pickup tubing

v

vacuum line

cleaning done before vacuum line cleaning, 1-37

cleaning procedure, 1-44
cleaning, when to clean, 1-37
vacuum trap
cleaning, 1-31
location, 1-31
when to check, 1-31
when to clean, 1-31
vent button
function, 2-6
location, 2-6
vent port
correct positioning, 2-21
venting
air bubbles, 2-6
vital stains
how to clean after using, 1-37
test for residual, 1-41

W

waste container
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add bleach, 2-16

capacity, 2-14

emptying, 2-14

location, 2-14

waste full indicator, 2-14
waste full indicator, 2-14
weekly procedures

clean the air filters, 1-2

clean the MCL sample head, 1-47

clean the sample probe, 1-47

See also schedule

INDEX
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The BECKMAN COULTER logo, COULTER CLENZ, CYTO-TROL, Immuno-Trol, and
IsoFlow are trademarks of Beckman Coulter, Inc.

All other trademarks, service marks, products, or services are trademarks or registered
trademarks of their respective holders.
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